
Overview
This chapter presents a series of basic tutorials that demonstrate various HVE
techniques and capabilities. The purpose of these tutorials is to provide a solid
grasp of the fundamentals of using HVE, and to help the user become as
efficient as possible. This is accomplished through a series of high-level,
task-oriented procedures using a step-by-step approach.

While this tutorial explores many of HVE’s important features, it does not
provide detailed explanations. For these details, the tutorial refers to specific
chapters, and the user should refer to those chapters when necessary.
Additional information, including a comprehensive index, may be found in the
Appendix.

+ NOTE: In addition to this tutorial, every EDC physics

model has a Program Manual that includes a

comprehensive tutorial specific to that physics model.

Manuals from 3rd party vendors typically include a

tutorial as well.
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The Tutorial is divided into four individual lessons:

• Lesson 1 - Navigating in HVE - This lesson is shows
techniques that promote efficiency. The user learns how to move
quickly within HVE to perform fundamental tasks.

• Lesson 2 - Running a Simulation Model - This lesson shows
the best way to set up and execute HVE-compatible physics
models (reconstructions and simulations involving human and
vehicle dynamics).

• Lesson 3 - Combining Multiple Events - This lesson
explains how to merge two or more individual simulations into a
coherent and seamless sequence involving multiple humans and
vehicles.

• Lesson 4 - Creating a Video - This lesson provides a quick
and easy lesson describing how to create your first video.

Let’s begin with the first lesson.

Lesson 1 - Navigating in HVE
Lesson 1 is a lesson in fundamentals, with an emphasis on efficiency. In this
lesson you will learn to perform the following fundamental tasks:

• Starting HVE

• Learning About the Menu Bar

• Managing Dialogs and Viewers

• Choosing an Editor

• Using Dialogs

• Using Viewers

• Shutting Down HVE

Do not skip this lesson! By spending time performing these tasks, you will be
able to navigate within HVE more quickly, more efficiently and (perhaps most
important) more intuitively! You’ll be able to effortlessly view the action from
the desired viewpoint. You’ll be able to set up your viewers to gain maximum
efficiency and information from what HVE is telling you. Put simply, this
lesson helps you get the most out of your HVE system. Let’s get started.

Starting HVE

To start HVE, use the Start, Programs cascade menu to select the HVE program
menu and then the HVE program icon, just as would start ary other program on
your computer. After starting HVE, the HVE Menu Bar and current HVE Editor
dialog are displayed (in this case it is the Vehicle Editor), as shown in Figure 32-1.
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+ NOTE: HVE saves the current editor when you exit; thus,

the editor now displayed is the one you were using when

you last exited HVE.

Learning About the Program Window

We will be using many terms throughout this (and other) tutorials. If you have
not worked with Windows before, many of these terms will be new to you. The
actions you will be performing will be new as well.

Let’s start off by identifying and experimenting with the components that
make up what is called the Menu Bar. Many of the functions accessed using
the menu option may also be selected by clicking on various toolbar buttons.
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Figure 32-1 The Desktop, after starting HVE. HVE has a main program window with a
Menu Bar, Tool Bar, integrated Event and Playback Controller, Viewer Manipulators
and Zoom Slider.



Menu Bar

A Menu Bar, shown in Figure 32-2, is common to all Window-type programs.
It contains the program’s fundamental options. In the case of HVE, these
options are File, Edit, View, Mode, Set-up, 3D-Edit, Options and Help. Let’s
briefly explore these options:

â Click on File. The File menu is displayed. This menu provides

basic system operations, such as starting new cases, opening and

saving files, working with video, printing and exiting HVE.

â Click on Edit. The Edit menu is displayed. This menu provides

operations that allow you to edit selected objects.

+ NOTE: No Edit menu options are currently available

because no object is selected. Other menus will also

have disabled options until the appropriate situation

allowing the use of the option is present.

â Click on View. The View menu options are displayed. This

menu provides operations that determine how you look at

simulations.

â Click on Mode. The Mode menu options are displayed. This

menu allows you to select which Editor you are currently

using, and also to add new or previous objects into the Editor

(e.g. Select Mode,Add, New or Previous).

â Click on Set-up. The Set-up menu options are displayed. This

menu allows you to enter inputs for setting up your simulation

or reconstruction events.

â Click on 3D-Edit. The 3D-Edit menu options are displayed.

This menu allows you to launch and close the 3D Editor while

in Enironment mode, plus edit material attributes, colors and

texturesor change manipulators while in the 3D Editor.
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Figure 32-2 Menu Bar. HVE’s menu bar is very traditional, with File, Edit, View, Mode,
Set-up, 3D-Edit, Options and Help menu options. It also includes the Dialog Control
button (a), the Title Bar (b), the Active Objects List (c), the Event Controller (d), the
Minimize and Maximize buttons (e), the Close button (f), and several toolbar buttons for
quick access to functions.

(a) (b) (e) (f)

(c) (d)



â Click on Options. The Options menu is displayed. This menu

provides several user-definable options and preferences.

â Click on Help. The Help menu is displayed. This menu

provides access to the various HVE Help System options.

The Dialog Control button is located in the upper left corner of the Menu Bar
(see Figure 32-2 (a), above).

â Click on the Dialog Control icon. The dialog control options

are displayed. These options allow you to move the dialog,

change its size, minimize it (replace the dialog with a small

icon - handy if you’re not currently using the dialog), and

maximize it (make the dialog as large as possible).

All dialogs and viewers have a Dialog Control button.

The Menu Bar also includes the Title Bar. This component (b) displays the
current case title, followed by the current filename in parentheses. All dialogs
and viewers also have a Title Bar, and it has an important function:

â Click on the Title Bar and drag the mouse. The dialog (i.e., the
HVE program window in this case) follows your mouse cursor.
This is a fundamental navigation task that allows you to move
dialogs and viewers anywhere you wish.

The Active Objects List is integrated into the Menu Bar. This component (c)
displays a drop-down list of active objects while in the Human, Vehicle,
Environment and Event mode. By clicking the button on the right side of the
list, the complete list of objects is displayed. The current object is displayed in
the viewer. To add a new object to the list, click on the Add New Object button
(looks like a + sign) located two buttons to the left of the list on the toolbar.. To
display the Information dialog for the current object, click on the Object Info
button (looks like a hand pointing) immediately to the left of the list on the
toolbar.
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Figure 32-3 Active Objects List drop-down display shown in Vehicle Mode. Add New
Object and Obejct Info toolbar buttons are located to the left of the list.



The Event (and Playback) Controller is integrated directly into the Menu Bar.
Additional information displays used in conjuction with the Event Controller
are shown in Figure 32-4. These information displays are as follows:

• Current Simulation Frame - Displays the current frame of

simulation output. A frame is equivalent to one timestep of output.

• Max Simulation Time - Displays the selected Simulation Controls

Maximum Simulation Time termination condition.

• Simulation Timestep - Displays the integration timestep used for

typical vehicle trajectory calculations as set in Simulation Controls.

• Current Simulation Time - Displays the current timestep of the

complete event.

• Output Interval - Displays the timestep interval used for display

result.s as set in Simulation Controls.

The Event Controller Slider can be used to move forward or backward through
each simulation frame. This provides the user with an easy means to locate a
specific point in a simulation, without having to Play and Stop the simulation.

The Menu Bar includes Minimize and Maximize buttons, as shown in Figure
32-2 (e).

â Click on the Minimize button. The dialog disappears! Actually,
it turned into an icon and is displayed along the bottom of the
Windows desktop.

â Click on the HVE icon. The current HVE program window is
redisplayed.

â Click on the Maximize button. The Menu Bar fills the screen.
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+ NOTE: Using the Maximize button to maximize the
program window allows you to use the whole screen for
your work. Setting your display to 1024 x 768 or 1280 x
1024 resolution provides you with an even larger work
area.

â Click the Maximize button again (which is now the Restore
button). The dialog returns to its original size.

Finally, the Menu Bar (and all windows and dialogs) includes a dialog frame
that surrounds the dialog. The dialog frame has two functions:

â Click on the frame and drag the mouse. The dialog changes size.

Depending on where you click on the frame, the dialog changes size in the
direction you drag. If you click on the corner, it changes size in both directions.

â Click and drag on various parts of the dialog frame,
experimenting with this feature.

+ NOTE: Some dialogs cannot be resized.

The second function of clicking on the frame is that it raises the dialog to the
top of the display, a useful feature if the dialog is partially covered and you
need access to it. We’ll explore this use later in this tutorial.
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Viewers

Viewers are used to display 3-D objects. A typical viewer is shown in Figure
32-5.

Viewers have the same window manager components that were just explored
using the Menu Bar. In addition, viewers also have the following components:

• Viewer Mode Selector - This component, shown in Figure 32-4 (a),

allows the user to switch between Pick mode, used for choosing objects

in the viewer and performing an editing operation on that object, and

Manipulate mode, used for changing the 3-D view using direct

manipulation.

• Viewer Controls - These components include Viewer X and Y rotation

thumb wheels, shown in Figure 32-4 (b), Dolly thumb wheel, Figure

32-4 (c), and Zoom slider, Figure 32-4 (d).

These components will be explored later in this tutorial.
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Figure 32-5 Typical Viewer. Pick Mode or Manipulate Mode is selected by choosing
the arrow or hand, respectively, near the upper right edge of the viewer (a). RotX and
RotY thumb wheels (b) rotate the object in the viewer about the viewer’s X and Y axes,
respectively. The Dolly thumb wheel (c) increases or decreases the size of the object by
moving the camera away from or towards the object. The Zoom slider (d) increases or
decreases the size of the object by reducing or increasing the viewer’s included angle.

(b)

(a)

(c)
(d)



HVE Mode Selector

The HVE Mode Selector is integrated into the toolbar at the left hand side of the
Main Menu. As shown in Figure 32-5, the Mode Selector has five buttons, as
follows (left to right):

• Human Editor Button - Displays the Human Editor, placing HVE in

Human mode.

• Vehicle Editor Button - Displays the Vehicle Editor, placing HVE in

Vehicle mode.

• Environment Editor Button - Displays the Environment Editor,

placing HVE in Environment mode.

• Event Editor Button - Displays the Event Editor, placing HVE in

Event mode.

• Playback Editor Button - Displays the Playback Editor, placing

HVE in Playback mode.

Let’s get a little practice using the HVE Mode Selector:

â Click on each button in the Mode Selector to display the

various HVE editors.
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Figure 32-6 HVE Mode Selector, located at the left hand
side of the toolbar. The Mode Selector is used to switch
between modes. The depressed button appearance
indicates the Vehicle Editor is currently selected.



Managing Dialogs and Viewers

Becoming an efficient HVE user requires using a few simple, but important,
procedures. These procedures include:

• Arranging your desktop to allow you to be as efficient as possible

• Raising viewers and dialogs to the top of the desktop

• Minimizing windows to help improve system performance
(especially for 3-D viewers that must be rendered)

Minimizing Windows

While using HVE, you may find your desktop becomes cluttered with
numerous data windows and viewers. This is especially true while using the
Playback Editor under the following two scenarios:

• You are working with a case that has multiple events and you have
created several outpu reports for each event.

• You are working with a case that has multiple Trajecotry
Simulation windows and you are in the process of rendering the
Playback Window containing multiple Trajectory Simulation
events.

In these instances, you can minimize the window containing the report so it
takes less screen space.

+ NOTE: A minimized window maintains all the data

associated with it; minimizing simply removes the visual

representation of the window and replaces it with and

icon.

+ NOTE: Minimized 3-D viewer windows are not rendered.

Because it takes time and computer resources to render

a window, minimizing 3-D viewer windows can

significantly speed up your work!

Let’s practice minimizing windows in the Playback Editor. Start by opening a
case:

â Click on File menu option and choose Open. The HVE File

Selection dialog is displayed.

â Select EdhisTutorialEDC and press OK.

â Choose No to the request to save the changes to the current case.

The selected case file is loaded into HVE and the Vehicle Editor displays the
current vehicle in the Active Vehicles list and 3-D viewer.

â Choose Playback mode. The Playback Editor is displayed, as

shown in Figure 32-7.

â Click on the Traj Sim window to bring it to the top of the desktop.
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â Click on the Dialog Control button and choose Minimize. The

Traj Sim window is turned into an icon as shown in Figure 32-8.
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Figure 32-7 Playback Editor with multiple reports. In this case, the
numerous reports make it difficult to manage the desktop, so we’ll iconify
the Traj Sim.

Figure 32-8 Playback Editor with multiple reports. This case differs from
Figure 32-7, above, in that one of the report windows has been iconified
(note the HVE Traj Sim icon is displayed along the bottom of the
desktop).



Choosing an Editor

HVE is designed around five fundamental editors. These editors are:

• Human Editor - Used for selecting and editing 3-D humans

• Vehicle Editor - Used for selecting and editing 3-D vehicles

• Environment Editor - Used for selecting and editing 3-D
environments

• Event Editor - Used for setting up and executing reconstruction
and simulation models

• Playback Editor - Used for creating visual and numeric output
reports and videos

This lesson teaches you how to quickly navigate between these editors. To
make this lesson a little more interesting and useful, we’ll use the current case
to illustrate the various HVE editors. Continuing from the previous discussion,
we’re in the Playback Editor. Let’s switch to Human mode.

+ NOTE: Switching to Human mode is synonymous with

selecting the Human Editor.

Switching editors is performed using the Mode Selector located at the left hand
side of the toolbar (refer to Figure 32-5). To switch to Human mode:

â Press the Mode Selector’s Human pushbutton. The Human

Editor is displayed with the current human, Female Adult

Pedestrian, selected in the Active Humans list and displayed in

the Human 3-D viewer (see Figure 32-9).

Switch to Vehicle mode:

â Press the Mode Selector’s Vehicle pushbutton. The Vehicle

Editor is displayed with the current vehicle, Plymouth Voyager

Van, selected in the Active Vehicles list and displayed in the

Vehicle 3-D viewer, as shown in Figure 32-10.

Next, let’s display the Environment Editor. To switch to Environment mode:

â Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment,

Untitled Environment, displayed in the Environment 3-D

viewer, as shown in Figure 32-11.

+ NOTE: There is no Active Environments list, because

there is only one environment.
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Figure 32-9 Human Editor with the active human, Female Adult
Pedestrian, displayed in the Human 3-D Viewer.

Figure 32-10 Vehicle Editor with the active vehicle, Plymouth Voyager
Van, displayed in the Vehicle 3-D Viewer. Contact surfaces, used for the
pedestrian impact simulation, are displayed on the vehicle if the Show
Contacts option is selected.
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Figure 32-11 Environment Editor with the current environment, Untitled
Environment, displayed in the 3-D viewer.

Figure 32-12 Event Editor with the current event, EDHIS, Buick/Ford, 90
deg, displayed in the 3-D viewer.



Switch to Event mode:

â Press the Mode Selector’s Event pushbutton. The Event Editor

is displayed with the current event, EDHIS, Buick Occupant,

displayed in the Active Events list and displayed in the Event

3-D viewer, as shown in Figure 32-12.

Switch to Playback mode:

â Press the Mode Selector’s Playback pushbutton. The Playback

Editor is displayed and several reports are displayed, as shown

in Figure 32-13.

+ NOTE: The Playback Editor displays all selected reports.

This allows you to compare results from several events.
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Figure 32-13 Playback Editor with several report windows displayed on the desktop.



Switch back to Vehicle Mode:

â Press the Mode Selector’s Vehicle pushbutton.

The Vehicle Editor is displayed with the current vehicle. Let’s change the
current vehicle:

â Choose Ford F-150 Fleetside in the Active Vehicles list. The

chosen vehicle becomes the current vehicle and is displayed in

the 3-D Vehicle viewer.

Let’s take a look at Ford F-150 Fleetside‘s basic vehicle attributes (Driver
Location, Engine Location, Number of Axles, Drive Axles):

â Click on the Object Info button on the toolbar.. The Vehicle

Information dialog for Ford F-150 Fleetside is displayed,

showing its basic attributes, as shown in Figure 32-14

â Press Cancel to remove the Vehicle Information dialog.
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Figure 32-14 Vehicle Information dialog, displaying the current vehicle’s basic attributes.



Switch to Environment mode:

â Press the Mode Selector’s Environment pushbutton. The

Environment Editor is displayed with the current environment

in the 3-D viewer.

Let’s take a look at the current environment attributes. These are displayed in
the Environment Information dialog. To display this dialog, perform the
following steps:

â Click on the Object Info button on the toolbar. The

Environment Information dialog is displayed, as shown in

Figure 32-15.

The Environment Information dialog is used for assigning physical event
information (sun position, wind direction and velocity for aerodynamics
calculations, air temperature and pressure for use in air density calculations,
and gravity constant, for NASA engineers doing Martian vehicle simulation).

The Environment Information dialog may also be used for assigning a 3-D
geometry file to drive on, as well as sky color and fog for visibility studies.

â Press Cancel to remove the Environment Information dialog.
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Figure 32-15 HVE Environment Editor, displaying the Environment Information
dialog. This dialog is used for assigning the primary environment attributes, such as
temperature, barometric pressure, and other information.



Using Dialogs

HVE has more than 200 dialogs for entering and editing information. All HVE
dialogs have default information already assigned. Therefore, when using a
dialog, you are always editing existing default data.

Modal vs Modeless Dialogs

HVE (and most other applications) use two different types of dialogs: Modal
and Modeless.

A modal dialog requires the user to complete an action by pressing OK or
Cancel before another action can be performed.

+ NOTE: You cannot make any other program selection

until you remove the modal dialog.

On the other hand, a modeless dialog allows you to enter and edit data in the
dialog, as well as to make selections from the menu bar and manipulate objects
in viewers while the dialog is still displayed.

Let’s explore the use of these dialogs. First, let’s look at a typical modal dialog:

â Click on File menu option and choose Open. The HVE File

Selection dialog is displayed.

â Using the HVE Mode Selector, choose Event mode.

Note that HVE beeps. This happens is because the File Selection dialog is a
modal dialog. You cannot perform any other operations until the File Selection
dialog is removed, either by pressing the dialog’s OK or Cancel button.

â Choose Cancel. The File Selection dialog disappears.

â Choose Event mode. The Event Editor is displayed, and the

current event is displayed in the 3-D viewer.

Now, let’s look at a modeless dialog. The most important example is the
Position/Velocity dialog used by the Event Editor:

â Click on Male Adult Driver‘s pelvis segment in the Event 3-D

viewer. The Position/Velocity dialog for the current human is

displayed, as shown in Figure 32-16.

+ NOTE: You can tell right away that the Position/Velocity

dialog is a modeless dialog because it does not have the

OK/Cancel/Help buttons like a modal dialog.
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Let’s get some practice using a modeless dialog:

â Place the mouse cursor in the Position/Velocity dialog’s Z

coordinate field and change the value to -20.00 inches from

-4.00 inches.

â Press the<Enter> key or the Apply button. The human’s

position is updated.

+ NOTE: Notice that nothing happened until you pressed

the <Enter> key! This is a big difference between modal

dialogs (with an OK button) and a modeless dialog:

Pressing OK on a modal dialog is like pressing <Enter>;

since a modeless dialog does not have an OK button,

you must explicitly press <Enter> for the value(s) in the

dialog to be updated.

+ NOTE: You can enter several values into the dialog, then

press <Enter> once to have all the values updated at the

same time. This can save some time when updating a

human’s or vehicle’s position, since HVE re-renders the

viewer whenever the viewer’s contents change.
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Figure 32-16 HVE Event Editor’s Position/Velocity dialog.



Using 3-D Viewers

HVE uses 3-D viewers to display humans, vehicles and the environment. Of
course, 3-D viewers are also used to visualize the motion of these objects
during Event and Playback modes.

HVE’s 3-D viewers have many features that make it easy for the user to select
how the 3-D objects are displayed. In particular, the user can perform the
following viewer operations:

• Resizing the viewer

• Panning the contents in the viewer

• Zooming in and out

• Dollying in and out

• Changing the camera position

These operations are described below.

Resizing Viewers

The size of the viewer is controlled by the user. To resize a 3-D viewer,
perform the following steps (refer to Figure 32-17):

â Close the Position/Velocity dialog still displayed on your
screen. Be sure Show Key Results has been selected from the
Options menu.

â Click on the right edge of the Key Results viewer frame (note
the cursor changes shape) and drag it to the left. The viewer
grows in width.

â Click on the lower edge of the viewer frame and drag it down.
The viewer grows in height.

â Click on the bottom left corner edge of the viewer frame and
drag it to the lower left corner of the screen. The viewer grows
in both width and height.

Notice by resizing the Key Results viewer, we’ve covered up the Event
ObjectsList viewer. Perform the following stes:

â Click on the left edge of the Event Objects List to bring the
dialogs to the top of the desktop.

+ NOTE: While 3-D viewers may be resized, dialogs

normally cannot.

Spend a few moments practicing resizing the viewers and bringing various
desktop objects to the top of the desktop.
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Panning

Panning involves moving the scene horizontally and vertically within the 3-D
viewer.

To pan the scene, perform the following steps:

â Confirm the viewer is manipulate mode (the current viewer
mode is set by clicking on the hand icon along the upper right
edge of the viewer). If necessary, click on the hand icon.

â Place the mouse cursor in the middle of the viewer.

â Press the middle mouse button and drag to the right. You may
also press the left mouse button while holding down the <Shift>
key to perform the same operation. The viewer contents are
dragged to the right, as shown in Figure 32-18.

â Press the middle mouse button and drag to the left. The viewer
contents are dragged to the left.

â Use the same procedures to drag the viewer contents up and
down.

Spend a few moments practicing panning the contents in the viewer.
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Figure 32-17 Using HVE 3-D viewers. Click on any edge and/or corner to resize the
viewer. In general make your viewers nice and BIG!



Zooming In and Out

Zooming involves changing the lens of the virtual camera that HVE uses to
display the objects in the viewer. The current zoom status and zoom slider are
located along the right end of the lower edge of the viewer.

To zoom in, perform the following steps:

â Click on the Zoom slider and drag the slider to the left. The

camera zooms in on the scene. This is analogous to changing

from a 50 mm camera lens to a 150 mm telephoto lens.

To zoom out, perform the following steps:

â Move the slider to the right. The camera zooms back away

from the scene. This is analogous to changing back to a 35 mm

lens.

Zoom back to the original camera state:

â Move the slider back to the left until the scene returns to its

original size in the viewer, as shown earlier in Figure 32-17.

Dollying In and Out

Dollying involves changing the camera position, moving it closer to, or further
away from, the object (just like in filming a movie scene). To dolly in and out,
perform the following steps:

â First confirm the viewer is in manipulate mode: Place the

mouse cursor in the middle of the viewer and press the

<Escape> key. The viewer switches modes, as indicated by

the icons along the upper right edge of the viewer.

â Press the mouse cursor in the middle of the viewer and press

<Escape> again, and again, and again... Note the viewer

toggles between Pick and Manipulate mode. Leave the viewer

in Manipulate mode.

+ NOTE: We’ve illustrated two equivalent methods for

switching viewer modes (clicking the viewer Mode icons

or pressing <Escape>. The method you choose is up to

you.

â Place the mouse cursor in the middle of the viewer.

â Press both the left and middle mouse buttons and drag down.

You may also press the left mouse button while holding down

the <Shift> + <Ctrl> keys to perform the same operation. The

camera dollys in, as shown in Figure 32-19.
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Figure 32-18 Panning the camera in a 3-D viewer.

Figure 32-19 Dollying the camera in a 3-D viewer.



â Place the mouse cursor in the middle of the viewer, press both

the left and middle mouse buttons and drag up. The camera

dollys out.

Let’s use a different method to dolly in and out:

â Click the mouse cursor near the top of the Dolly thumb wheel
(located along the lower right edge of the viewer) and drag
down. The camera dollys in.

â Drag the Dolly thumb wheel up. The camera dollys back.

â Click on the Dolly thumb wheel and drag the mouse cursor to

the top of the viewer. The camera dollys waaaaaaaay back.

+ NOTE: We’ve just illustrated the thumb wheel’s range of
motion is not limited by its visible size.

+ NOTE: We’ve also illustrated you can dolly in and out
using direct manipulation in the viewer or using the Dolly
thumb wheel. These two methods are equivalent. The
method you use is up to you.

Use either method (direct viewer manipulation or Dolly thumb wheel) to dolly
back in until the vehicle returns to its original size.

+ NOTE: Both dollying and zooming appear to have the
same effect, that is, to make objects appear larger.
However, if you zoom in too close, the objects become
distorted just as if you were using a fisheye lens. For this
reason, we recommend dollying instead of zooming if
your goal is to get a close-up view.

Changing Camera Position

The final task we need to learn about viewer manipulation is changing camera
position.This isavery important task,because ifyou’regoodat it,youcanquicklyand
effortlessly look exactly where you want to look. The initial view of the vehicle was
shown earlier in Figure 32-17. To look at the back of the vehicle, perform the
following steps:

â Place the viewer in Manipulate mode, using either of the

methods described above.

â Place the mouse cursor about 2 inches (5 cm) to the left of the

center of the viewer.

â Click the left mouse button and drag the mouse horizontally.

The vehicle spins about the viewer’s vertical axis.

â Place the mouse cursor about 2 inches below the center of the

viewer.
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â Click and drag the mouse vertically. The vehicle spins about
the viewer’s horizontal axis.

â Place the mouse cursor somewhere else in the viewer (you
choose the location) and drag vertically. The vehicle spins
about the center of the viewer.

+ NOTE: This is an important concept! While using direct

manipulation of the viewer, it always spins about the

center of the viewer.

â Spend a moment or two to practice using direct manipulation
to change the view. As a final exercise, see how quickly and
easily you can recreate the view shown in Figure 32-20.

+ NOTE: We suggest deciding on an area of the vehicle to
look at, then see how quickly you can manipulate the
scene to get it in the middle of the viewer.

As a final tutorial exercise, continue looking at various parts of the vehicle
using direct manipulation and a combination of panning (middle mouse or left
mouse + <Shift>), dollying (left and middle mouse or left mouse
+<Shift>+<Ctrl>) and rotating (left mouse). Spend some time here! By
mastering the task of viewer manipulation, you will benefit every time you use
HVE. In particular, you will be able to work faster, and you will be able to
better visualize your work.
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Figure 32-20 Moving the camera in a 3-D viewer.



Shutting Down HVE

When you are finished working with HVE, you will end your session by saving
your work and exiting HVE. It is important to exit HVE gracefully because
HVE asks you to save your work if it has changed since your last save, and
because HVE updates your configuration file so your next HVE session uses
the same preferences and options you’ve selected for use in the current session.
HVE also saves the current editor when you exit; thus, when HVE is next used,
it will display the same editor you were using when you last exited HVE.

To shut down HVE:

â Click on the File menu and choose Exit.

Because your work case file has changed since your last save, HVE asks you to
save or cancel these changes.

â Choose No.

HVE is shut down and you may now go have lunch.
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Lesson 2 - Running a Simulation Model
Lesson 2 is a high-level overview describing how to use HVE to execute a
single event (reconstruction or simulation program). In this tutorial, we’ll
execute an EDVSM simulation.

In this lesson you will learn to perform the following tasks:

• Selecting Humans

• Selecting Vehicles

• Selecting Environments

• Creating Events

• Setting Up Events

• Executing Events

Mastering these tasks is important because they are the same tasks you’ll use
every time you use HVE - regardless of the reconstruction or simulation model
you’re executing.

Let’s get started. Before we can get into the individual tasks, we need to have
HVE up and running:

â If necessary, start HVE and arrange your desktop.

+ NOTE: If you don’t know what we are talking about,

return to Lesson 1!

Selecting Humans

We’ll start by adding a human to our case:

â Switch to Human mode. The Human Editor is displayed.

Let’s add a 50th percentile male adult:

â Click Add New Object. The Human Information dialog is
displayed. The Human Information dialog includes option
buttons allowing the user to select a seat position within the
vehicle (alternatively, Pedestrian could be selected), and
assign the human’s attributes according to Sex, Age, Weight
Percentile and Height Percentile.

â Using these option buttons, click each button to choose the

following human attributes:

• Location = Front, Left

• Sex = Male

• Age = Adult

• Weight Percentile = 50

• Height Percentile = 50
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Let’s replace the default name with more meaningful one:

â Enter: Fred.

â Press OK.

Fred is displayed in the Human Editor’s 3-D viewer, as shown in Figure
32-21. He is in a seated position because we assigned Fred as an occupant.

Spend a few moments visualizing Fred using the techniques we used in
Lesson 1 (Using 3-D Viewers).

+ NOTE: If you spin him really fast, Fred should appear to

be break dancing.

Selecting Vehicles

Now, let’s add a 1968 Dodge Charger to the case:

â Choose Vehicle Mode. The Vehicle Editor is displayed.
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Figure 32-21 Human Editor with Fred displayed in the 3-D viewer.



â Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to Type, Make,
Model, Year and Body Style.

+ NOTE: The Vehicle Information dialog also allows you to
edit the Driver Location, Engine Location, Number of
Axles and Drive Axle(s). These options affect the basic
vehicle configuration and do not need to be changed for
our tutorial.

â Using the option buttons, click each button to choose the

following vehicle from the database:

• Type = Passenger Car

• Make = Dodge

• Model = Charger

• Year = 1968 - 1970

• Body Style = 2-Door

â Click OK to add Dodge Charger to the Active Vehicles list.
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Figure 32-22 Vehicle Editor with Dodge Charger 2-Dr displayed in the 3-D viewer.
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The 1969 Dodge Charger is displayed in the Vehicle Editor’s 3-D viewer, as
shown in Figure 32-22.

Again, visualize the Charger, spinning it around and dollying in and out.

Selecting Environments

Next, let’s add an environment to the case.

â Switch to Environment mode.

â Click on Add New Object. The Environment Information

dialog is displayed.

Let’s not bother with all the options here. But, we do want an environment to
drive on.

â Choose Open. The 3-D Geometry File Selection dialog is

displayed (see Figure 32-23).

If the current format option is not HVE:

â Click on the Files of Type option list and choose HVE files.

3-D geometry files of the HVE format are displayed in the

listbox.

Now, let’s select a 3-D geometry file for our EDVSM event:

â Scroll down and choose 4x2_Intersection.h3d.

â Press OK. The File Selection dialog is removed.

Next, let’s replace the default environment name (Untitled Environment):

â Enter Tutorial Lesson 2 Intersection

â Press OK.

The selected environment is displayed in the Environment Editor’s 3-D
viewer, as shown in Figure 32-24.

Spend a few moments spinning it around and dollying in and out.

+ NOTE: We hope you are becoming an expert at using the

viewer controls to visualize 3-D objects. This is an

important part of becoming an efficient HVE user.
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Figure 32-23 3-D Geometry File Selection dialog, used for selecting a 3-D geometry file for
driving on. The Files of Type options list allows us to select the HVE file format.

Figure 32-24 Environment Editor with Tutorial Lesson 2 Intersection displayed in the 3-D
viewer.
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Event Editor

Now, let’s get to the major focus of this lesson: Using the Event Editor. This
involves three steps:

• Creating the Event - This step involves choosing the humans
and vehicles, and the calculation method (reconstruction or
simulation model) for the event.

• Setting Up the Event - This step involves assigning the
position and velocity for each human and vehicle in the event. This
step can also involve assigning driver controls, restraint systems,
damage profiles, and numerous other event set-up options for each
object, as well as assigning simulation controls and various
calculation-specific options.

• Executing the Event - This step involves pressing the Execute
pushbutton and observing the results. It also normally involves
making adjustments to specific input parameters to improve the
results as well as to perform range-checking runs to identify
potential sensitivities in various input parameters.

Let’s create our event:

â Switch to Event Mode.

â Click on Add New Object. The Event Information dialog is

displayed, as shown in Figure 32-25 on the following page.

Among its components, the Event Information dialog contains

the Active Humans list, Active Vehicles List and Calculation

Method option list. These are the key components required for

creating an event.

â Select the Dodge Charger from the Active Vehicles list. It is

added to the Event Humans & Vehicles list.

â Click on the Calculation Method option list and choose

EDVSM.

â Change the default event name. Enter Sample Event.

â Press OK.

We have created an EDVSM event using the Dodge Charger. The Event 3-D
viewer displays our environment.

+ NOTE: Although our human, Fred, is available for service

for an occupant crash simulation, we’re not going to use

him in our tutorial (right now, Fred’s feeling pretty lucky).
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Figure 32-25 Event Information dialog, used for creating events. Creating an
event involves choosing the humans, vehicles and calculation method that will
be used for the event.
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The next step is to set up our event. For our sample event, we’ll need initial
position and velocity and a steer table. Let’s proceed:

â If necessary, select Dodge Charger in the Event Humans &

Vehicles list.

â Choose Set-up from the menu bar. The Event Set-up options

for EDVSM are displayed in the Set-up menu, as shown in

Figure 32-26.

+ NOTE: If no object is selected, no options will be enabled

in the Set-up menu.

+ Only the event set-up options applicable to EDVSM are

displayed in the Set-up Menu. That’s because each

physics program tells HVE which set-up options to make

available in the Set-up Menu.

â Select Position/Velocity. The Initial Position/Velocity dialog

is displayed and the Dodge Charger appears in the Event 3-D

viewer at the earth-fixed origin (see Figure 32-27).

â Enter the initial position coordinates: Place the mouse cursor in

the X-coordinate field and enter -70.0 ft. Place the mouse

cursor in the Y-coordinate field and enter 37.5 ft.

â Enter the initial velocity: Place the mouse cursor in the Total

Velocity field and enter 25.0 mph, followed by <Enter>.

+ NOTE: We just did something subtle but smart: We

waited until we had entered all our data before pressing

<Enter>. We absolutely must press the <Enter> key to

update the position and velocity. However, by waiting

until we entered all the data before pressing <Enter>, we

saved some time because the 3-D viewer was only

updated once. If we pressed <Enter> after entering each

individual coordinate value, the 3-D viewer would need to

be re-rendered three times.

+ NOTE: Clicking the Apply button is the same as pressing

the <Enter> key.
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Figure 32-26 Event Editor’s Set-up Menu. The Set-up Menu is used for setting up the
event by entering event-related parameters for the selected human or vehicle.

Figure 32-27 Event Editor just after placing our Charger into the event. Its default
location is the earth-fixed origin.
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Now, let’s enter the steer table. For our example, we’ll enter a simple left turn:

â Choose Set-up from the menu bar. The Event Set-up options

for EDVSM are displayed.

â Select Driver Controls. Select the Steer tab on the dialog. The

Steer Table dialog for the Dodge Charger is displayed.

â Enter the steer table, as shown in Table 32-1, below (see also

Figure 32-28):

â Press OK to accept the steer table.

Use the Event Controller, shown in Figure 32-29, to execute the EDVSM
event. The Event Controller’s buttons have the following functions, as
described from right to left:

• Reset - Reinitialize the calculation model for re-execution

• Rewind to Start - Return to the start of the simulation

• Reverse - Play the simulation backwards

• Pause - Pause the simulation

• Execute/Play - Execute the event or play the simulation forwards

• Advance to End - Advance to the end of the simulation

+ NOTE: If you make changes to any of the event set-up

options (see previous section), those changes will have

no effect unless you press Reset before pressing Play.
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Time
(sec)

Steering Wheel
Angle

(Degrees)

0.00 0.0

0.50 0.0

1.00 -150.0

3.50 -150.0

4.00 0.0

Table 32-1. Steer Table Table entries for the
Dodge Charger’s left turn.



To execute the event:

â Press Execute/Play.

The Dodge Charger begins moving as its motion is simulated according the
Charger vehicle model, the current environment terrain, the initial position and
velocity, and the specified driver steering inputs. See Figure 32-30. The
vehicle simulation continues until the default maximum simulation time, 5.0
seconds, is reached.
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Figure 32-28 Steer Table dialog. Use this dialog to enter an open-loop steering table as a
function of time. The steer table data are presented in the table below.

Figure 32-29 The Event Controller functions like a VCR controller.
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Let’s replay the event a few times, illustrating some useful options.

â Using the Event Controller, press Rewind.

+ NOTE: Pressing Rewind allows us to rerun the event

without re-executing the simulation; it simply redisplays

the current output tracks. This saves a little time because

the physics calculations are not re-executed.

As technical people, we tend to be interested in numeric data (as opposed to
simply a nice animation of the motion). These numeric results are displayed in
Key Results windows for each timestep while the simulation is executed. Our
example includes a Key Results window for the Charger. If a Key Results
window is not displayed on your desktop, let’s display it:

â Choose Options from the menu bar, and click Show Key

Results. The Key Results window for the Dodge Charger is

displayed.
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Figure 32-30 Event Editor while executing the event. We’ve dollied in closer for a better
view. Feel free to practice your viewer manipulation skills.



By default, the vehicle’s Sprung Mass Kinematics results are displayed (see
Figure 32-31). Let’s add Tire Forces to the Key Results window:

â Click on Select Variables in the Key Results window. The

Variable Selection dialog is displayed.

â Click Tires, Axle 1, Right, Outer.

The Variables listbox for the select tire is displayed.

â Select Fx, Fy and Fz.

â Press OK.

The selected variables are added to the Key Results window (scroll down or,
better yet, drag down the bottom of the Key Results window to increase its size
so you can see all the window’s results). The Event Editor with the Key Results
window is shown in Figure 32-32.

â Using the Event Controller, press Execute/Play. The event is

redisplayed, showing the selected Key Results for each

timestep.
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Figure 32-31 Variable Selection dialog for selecting Key
Results.



Spend a few moments replaying the event from different views, changing the
camera position, panning and dollying in and out, using the techniques you
learned earlier.

+ NOTE: Like all events, our EDVSM event has produced

several output reports (Accident History, Messages,

Vehicle Data and several others). The Playback Editor is

used to view (and possibly print) these reports. Refer to

the EDVSM Program manual (or other program manual

for a different simulation program) for further information.

This concludes Lesson 2 - Running a Simulation model. You can go ahead and
shut down HVE or proceed directly to Lesson 3.
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Figure 32-32 Event Editor with Key Results window displaying tire forces for the right
front tire.



Lesson 3 - Combining Multiple Events
Most crashes involve a sequence of events (e.g., loss of control, collision,
occupant ejection). HVE’s open architecture allows users to choose the tool
best suited for each specific event from a wide variety of reconstruction and
simulation tools. The HVE Playback Editor includes the ability to combine
these individual events into a single window, and to edit the sequence so each
event is timed properly with respect to the other events. The result is a
seamless, real-time view of the entire multiple-event sequence.

Lesson 3 is a tutorial describing how to use the HVE Playback Editor to
combine multiple events into a single, coherent sequence.

In this lesson you will learn to perform the following tasks:

• Displaying Multiple Trajectory Simulation Events

• Combining the Multiple Events Into a Single Playback Window

• Editing the Time Sequence for the Events

As s result of performing these tasks, you will have prepared a powerful and
compelling visualization of an entire multi-event collision sequence. These
tasks are also a prerequisite for creating video output, the subject of Lesson 4.

Let’s get started. Before we can get into the individual tasks, we need to have
HVE up and running:

If necessary, start HVE.

+ NOTE: If you don’t know what we are talking about,

return to Lesson 1!

We’ll start by opening an existing case in which several events have already
been executed. We can use this case to illustrate the use of the HVE Playback
Editor. Start by opening the case:

â Click on File menu option and choose Open. The HVE File

Selection dialog is displayed.

â Select HveTutorialLesson3EDC and press OK.

The selected case file is loaded into HVE and the current editor (Human Editor,
Event Editor...) displays the latest object in its Active ‘Objects’ list. We’ll start
by reviewing the previously executed events:

â If the Event Editor is not currently displayed, choose Event

mode.

The Event Editor is displayed.
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Our tutorial case includes five events. The last of the five events, EDVDS,
Tractor-Trailer Avoidance, is displayed in the Event 3-D Viewer, as shown in
Figure 32-33. The complete list of events in the Active Events list is as follows:

• Event 1 - EDSMAC4, 3-Vehicle Crash. The three vehicles are a
Ford Taurus, a Honda Accord, and a Chevrolet Suburban.

• Event 2 - EDVSM, Ford Taurus Post-impact.

• Event 3 - EDVSM, Honda Accord Post-impact.

• Event 4 - EDVSM, Chevrolet Suburban Post-impact.

• Event 5 - EDVDS, Tractor-trailer Avoidance.

Let’s go through the individual events, one at a time:

â Choose EDSMAC4, 3-Vehicle Crash from the Active Events

list. EDSMAC4, 3-Vehicle Crash is displayed in the Event

Viewer. All vehicles are displayed at their initial positions.

â Using the Event Controller, press Play. EDSMAC4, 3-Vehicle

Crash is visualized in the Event 3-D viewer.

+ NOTE: You are encouraged to manipulate the scene in
the 3-D viewer and watch the event from different
perspectives.
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Figure 32-33 Event Editor. The Active Events list displays the names of five
events that were part of the case file we opened. The last of these events,
EDVDS, Tractor-trailer Avoidance, is displayed in the 3-D viewer.



Now, let’s look at the second event, EDVSM, Ford Taurus Post-impact:

â Choose EDVSM, Ford Taurus Post-impact, from the Active
Events list. EDVSM, Ford Taurus Post-impact is displayed in
the Event 3-D viewer, with the Ford Taurus at its initial
position.

â Press Play and watch as EDVSM, Ford Taurus Post-impact is

visualized in the 3-D viewer.

Now, let’s look at the third event, EDVSM, Honda Accord Post-impact:

â Choose EDVSM, Honda Accord Post-impact, from the Active
Events list. EDVSM, Honda Accord Post-impact is displayed
in the Event 3-D viewer, with the Honda Accord at its initial
position.

â Press Play and watch as EDVSM, Honda Accord Post-impact

is visualized in the 3-D viewer.

+ NOTE: These events begin at separation, not at the start

of the entire sequence.

Repeat the above steps to review the remaining two events. We encourage you
to practice becoming an expert using the viewer controls.

Displaying Multiple Trajectory Simulations

Now, let’s use the HVE Playback Editor to combine the events into a single
sequence.

â Choose Playback mode. The Playback Editor is displayed, as

shown in Figure 32-34.

Initially, no reports are displayed. Let’s add our Trajectory Simulation reports:

â Click Add New Object. The Report Window Information

dialog is displayed, showing each of our events in the Active

Events list, as shown in Figure 32-35 on the following page.

â Select the first event in the Active Events list, EDSMAC4,

3-Vehicle Crash.

â Click on the Select Output option list and choose Traj Sim.

â Press OK.

The Trajectory Simulation window for the first event is displayed (see Figure
32-36).
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Figure 32-34 Playback Editor. Initially, no reports have been created, so only the
Playback Editor and HVE Menu Bar are displayed.

Figure 32-35 Report Window
Information Dialog. The Active Events

list displays the name of each of the
five events in our case. The Select
Output options list includes all the

available reports for the selected event.



Let’s add the second event:

â Click Add New Object. The Report Window Information

dialog is displayed. Select EDVSM, Ford Taurus Post-impact

from the Active Events list.

â Click on the Select Output option list and choose Traj Sim.

â Press OK.

The Trajectory Simulation window for the second event is displayed (see
Figure 32-37).

Using the above procedures, add the remaining three Trajectory Simulation
windows. After adding the fifth window and arranging them somewhat, your
desktop should appear as shown in Figure 32-38.
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Figure 32-36 Trajectory Simulation window for our first event, EDSMAC4, 3-Vehicle
Crash. You may wish to spend a few moments using the viewer controls to choose the
view you like.
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Figure 32-37 Trajectory Simulation window for our second event, EDVSM, Ford Taurus
Post-impact. Again, spend a few moments using the viewer controls to choose the view
you like.

Figure 32-38 Desktop with Playback Editor and five Trajectory Simulation windows.



Editing the Time Sequence

Three of the five events require editing the start time in order to make the
motion for the event to begin at the proper time. Because these events begin at
separation following the 3-vehicle collision, we can easily get the times for the
start of the individual events. These times are available in the Accident History
report from our first event, EDSMAC4, 3-Vehicle Crash. To display the
Accident History report for this event, perform the following steps:

â Click Add New Object. The Report Window Information

dialog is displayed (shown earlier in Figure 32-35).

â Select EDSMAC4, 3-Vehicle Crash.

â Click on the Select Output option list and choose Accident

History.

â Press OK.

The Accident History report for EDSMAC4, 3-Vehicle Crash is displayed, as
shown in Figure 32-39.
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Figure 32-39 Accident History report for EDSMAC4, 3-Vehicle Crash. This report provides
the time of separation for each of the three vehicles. We will use this information to
establish the proper timing between events.



Using the Accident History report, we find that separation for the three
vehicles are as follows:

• Event 2 - EDVSM, Ford Taurus Post-impact. According to the
Accident History report, separation begins at 9.03 seconds.
However, note that the vehicle still has residual velocity left at the
end of simulation time (10.0 seconds), so we will use the final
position for the start of the this event.

+ NOTE: This vehicle is involved in two impacts; we choose
the end of the second impact (with the Chevrolet
Suburban) for our separation conditions.

• Event 3 - EDVSM, Honda Accord Post-impact. According to the
Accident History report, separation occurs at 8.40 seconds.

• Event 4 - EDVSM, Chevrolet Suburban Post-impact. According
to the Accident History report, the event’s starting time must be
delayed until separation occurs at 9.03 seconds.

Editing the event sequence is performed using the Playback Window. In the
next step, we will delay the timing for individual events displayed in the
Playback Window to correspond with the values we just found in the Accident
History report.

Combining the Multiple Events

Now we’re ready to create a Playback Window that combines the motion for
all five events:

â Select Options, Add Playback Window from the main menu.
The Playback Window is displayed, as shown in Figure 32-41.
The Active Trajectory Simulations list displays all five
Trajectory Simulation windows in the order that we created
them.

â Make sure all five Trajectory Simulations are selected for

display in the Playback Window (indicated by the check

boxes next to the event name).

Now we’re ready to set the timing of each event to create a properly timed
sequence of events. To edit the start time for EDVSM, Ford Taurus
Post-impac, EDVSM, Honda Accord Post-impact, and EDVSM, Chevrolet
Suburban Post-impact, perform the following steps:

â Locate the Tdelay field for EDVSM, Ford Taurus Post-impact,

and enter 10.0000 seconds, followed by <Enter>.
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Figure 32-41 Playback Window Dialog. Use the viewer controls to manipulate the view to
your liking.

Figure 32-42 The Active Trajecotry Simulations list displays the name of each of the five
trajectory simulations in our Playback Editor.



+ NOTE: We must press <Enter> for the data to be accepted
because this is a modeless dialog (refer to lesson 1 if you
need a refresher on modal vs modeless dialogs).

â Locate the Tdelay field for EDVSM, Honda Accord

Post-impact, and enter 8.4000 seconds, followed by

<Enter>.

â Locate the Tdelay field for EDVSM, Chevrolet Suburban
Post-impact, and enter 9.0300 seconds, followed by
<Enter>.

Now we’re ready to display the properly timed sequence of events. The
Playback Window contains all five selected events. Let’s view the (properly timed)
accident sequence:

â Press Play.

The playback window shows the entire sequence properly timed. Although
you cannot tell by inspection, the motion for all three colliding vehicles is first
handled by EDSMAC4, then transferred to EDVSM following their impact.
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Figure 32-43 Playback Window Audit Trail, displaying a table containing the
events that are controlling the motion of each object in the Playback Window.



Let’s display the Audit Trail for the current Playback window. The Audit Trail
is a table report of each event in the Playback window. To display the Audit
Trail, perform the following steps:

â Press Audit Trail.

A table describing the event sequence is displayed in Figure 32-43.

+ NOTE: The Audit Trail tells the user which events are

controlling the motion in the Playback window.

â Press OK. The Audit Trail is removed.

Spend a few moments manipulating the view. Dolly in and watch the motion of
the sequence from different perspectives.

When you are finished reviewing the results, let’s save the case file. We’ll use
it in our next lesson.

+ NOTE: Our next lesson describes how to route this

Playback Window directly to videotape.

To save the case file, perform the following steps:

â Click on the File menu option and choose Save. The HVE File

Selection dialog is displayed.

â Enter a case title: Combining Multiple Events.

+ NOTE: The Case Title appears as a heading on all

printed output reports.

â Enter a filename: HveTutorialLesson4.

â Press OK.

The data are saved in file HveTutorialLesson4; this file may be found in the
HVE\supportFiles\case subdirectory.

This concludes Lesson 3 - Combining Multiple Events. You can now shut
down HVE or proceed directly to Lesson 4.
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Lesson 4 - Creating a Video
The final task while using HVE often includes creating a videotape of the crash
sequence. Because it is visual, a videotape presentation is often the best means
of describing and explaining how a crash occurred.

HVE’s Playback Editor includes an integrated video output interface that
allows you to produce a simulation movie without the need for additional
software. If you wanted to create a full-length movie containing one or more
views of the crash sequence, then you would need to use a software program
dedicated to editing movie clips together.

Lesson 4 is a tutorial describing how to use the HVE Playback Editor to create
a simulation movie of the complete crash sequence.

In this lesson you will learn to perform the following tasks:

• Route a multi-event crash sequence to a video compressor

• Replay the sequence in real time

• Save the sequence to a Video for Windows (AVI) file

Asa result of performing these tasks, you will have prepared a powerful and
compelling visualization of an entire multi-event collision sequence.

Let’s get started. Before we can get into the individual tasks, we need to have
HVE up and running:

If necessary, start HVE and arrange your desktop.

+ NOTE: If you don’t know what we are talking about,

return to Lesson 1!

Let’s first confirm that the video compressor you wish to use is selected. Let’s
check our video set-up:

â Click on the File menu option and choose Video. The HVE

Video Set-up dialog is displayed, as shown in Figure 32-44 on

the following page.

â Click on the Compressor option list and scroll through the list

of available choices. Choices you may wish to consider are

Full Frames (uncompressed), Microsoft Video 1, or Cinepak

Codec. For this tutorial, select Microsoft Video 1 from the list

and then press OK.

â Press OK on the Video Set-up dialog after setting or

confirming your compressor selection.

Your HVE Video Interface is now ready to use for creating a simulation movie
file.
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+ NOTE: You can skip the next step if you just finished
Lesson 3 and you’re still in the Playback Editor with all
your reports displayed. If this is the case, proceed with
the next section, Route to Video Compressor, below.

Let’s open a case file that contains a playback window that we want to route to
video:

â Click on File menu option and choose Open. The HVE File

Selection dialog is displayed.

â Select HveTutorialLesson4EDC and press OK.

The selected case file is loaded into HVE and the current editor (Human Editor,
Event Editor...) displays the latest object in its Active ‘Objects’ list. We’ll start
by going directly to the Playback Editor:

â If the Playback Editor is not currently displayed, choose Playback
mode. The Playback Editor is displayed, along with the five
Trajectory Simulation 3-D viewers.

+ NOTE: These reports might be minimized in a single
stack located in the bottom left corner of the desktop. If
this is the case, drag them onto your desktop and
arrange them to your liking.

We’re now ready to proceed.

32 - 53

Lesson 4 - Creating a Video HVE Tutorial

T
U

T
O

R
IA

L

Figure 32-44 HVE Video Set-up Dialog used for
selecting video devices and AVI files.



Route to Video Compressor

Let’s begin with a short discussion about the HVE video interface. It has three
simple components:

• Playback Controller - a VCR-like panel that allows you to
display and record the results of your simulation

• Source Option List - an option list containing all the possible
sources of the simulation displayed in the Playback Window

• Destination Option List - an option list containing all the
possible devices that can receive the simulation displayed in the
Playback Window.

The Option Lists are shown in Figure 32-45. Think about the Source and
Destination options for a moment. It is really a simple concept: Get the
simulation from Source and put it Destination. To route our simulation to AVI,
we choose Untitled Playback Window as our Source and AVI as our
destination. Let’s proceed:

â Click on the Source option list. The three options are
displayed: Untitled Playback Window, S-Video/Composite
Video and AVI.

â Choose Untitled Playback Window.

+ NOTE: The above step was obviously unnecessary,
since Untitled Playback Window was already selected.
We asked you to perform this task just to help you better
understand the available options.

â Click on the Destination option list. Again, two options are
displayed.

â Choose AVI.

Because we already created the Playback Window in Lesson 3, we have
already done most of the work. Let’s perform a couple of final checks:

â Confirm the current simulation time is 0.0000 seconds (otherwise

we’d start recording after the beginning of the sequence).

â Click on the Options menu option and choose Playback. The
Playback Options dialog is displayed. Confirm the Playback
Interval is set to 0.0333 seconds (NTSC video) or 0.0250
seconds (PAL video). Press OK after confirming the correct
Playback Interval.

+ NOTE: If you halve the Playback Interval, the simulation

will record twice as many frames, which will help

preserve the quality of the movie file if played in slow

motion (twice as slow as normal) in an external program.
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â Confirm that you have set the view in the Playback Window to
your liking. If desired, manipulate the 3-D viewer to set the
desired perspective. An example is shown in Figure 32-46.

â Finally, confirm no other windows are covering the Playback

Window. Otherwise, they will show up in your simulation

movie.

Now, we’re ready to record our simulation:

â Press Play.

The simulation is recorded to the disk. The simulation is also displayed in the
Playback Window so you can monitor its progress.

+ NOTE: It takes about 3 seconds per frame to record to
AVI. You may wish to go get a cup of coffee (or tea) while
recording.

Replay in Real Time

After the simulation has been recorded to disk using the video compressor, we
can replay the entire sequence in real time. Again, think about the Source and
Destination options for a moment. All we need to do is switch the current
Source and Destination!

To replay the sequence in real time, perform the following steps:

â Click on the Source option list and choose AVI.

â Click on the Destination option list and choose Untitled

Playback Window.

â Press Play.
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Figure 32-45 Close-up of part of the
Playback Window Dialog, used for
playing and recording simulations.



The simulation data is retrieved from the disk and displayed in real time in the
Playback Window.

+ NOTE: The viewer controls are not available while
replaying a AVI simulation. That’s because the view was
established when we recorded the simulation and cannot
be modified once it has been recorded.

Route to Videotape

The next step in Lesson 4 is to create the videotape. Again, once the simulation
has been recorded to disk using the video compressor, we can replay the entire
sequence in real time. However, this time we’ll choose our video device as the
Destination.
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To record the sequence in real time, perform the following steps:

â Click on the Destination option list and choose
S-Video/Composite Video.

â Activate the video out capability of your computer.

â Press the Play button on the Playback Controller to activate a

special display designed to integrate with the computer’s

video subsystem.

â Turn on your VCR.

â Insert a good-quality, blank tape in the carriage.

â Advance the tape about 20 seconds (this provides 20 seconds

of leader).

â Press the VCR’s Record button to begin recording.

+ NOTE: You may wish to use the VCR’s Pause button

until you are ready to begin the video transfer from HVE.

â After the VCR has recorded 5 seconds, press the Play button
on the special display viewer.

+ NOTE: By waiting 5 seconds, HVE records an initial still
image 5 seconds in length. This is a wise video
technique; it allows the viewer to become prepared for
what he or she is about to view.

â After the HVE simulation sequence is finished, wait another 5
seconds.

â Press the VCR’s Pause or Stop button.

+ NOTE: Again, waiting 5 seconds provides an additional

opportunity for the viewer to interpret what he/she just

viewed.

Saving the AVI File

The final step in Lesson 4 is to save the simulation movie file for convenient
future viewing. To save the AVI file, perform the following steps:

â Click on the File menu option and choose Video. The Video

Set-up dialog is displayed.

â Choose Save As. The HVE File Selection dialog is displayed.

â Enter a filename: HveTutorialLesson4.

â Press OK.
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The AVI video is saved in file HveTutorialLesson4; this file may be found in
the hve\supportFiles\images\movies subdirectory.

+ NOTE: HVE appends the .avi extension, so the file is
listed as HveTutorialLesson4.avi.

â Press OK again to remove the Video Set-up dialog.

Changing the View

Figure 32-46 shows a view of the crash scene from an interesting perspective.
All the collision action is displayed. However, it does not show what each
driver saw as the crash sequence evolved. These views are obviously
important: By viewing the sequence as seen by each driver, it’s actually rather
obvious how the crash occurred and which driver made the first mistake.

To view the sequence from each driver’s perspective, we simply atttach a
virtual camera to each vehicle and replay the simulation. The view is attached
to the vehicle as it moves. To attach the camera to the vehicle and view the
crash scene from the driver’s perspective, perform the following steps:

â Click on the View menu and choose Set Camera. The Set

Camera dialog is displayed, as shown in Figure 32-47.

â Click the View From option list and choose Honda Accord. 4-Dr.

â Replace the current Camera coordinates with the location of

the driver’s head. Enter x = 0.0 ft, y = -1.5 ft, z = -2.0 ft

â Replace the current Picture Center coordinates with the

vehicle-fixed location directly ahead of the driver. Enter x

= 100.0 ft, y = -1.5 ft, z = -2.0 ft .

+ NOTE: These coordinates are vehicle-fixed; thus, the

y and z coordinates remain unchanged. Only the

x-coordinate changes to reflect the fact that the driver is

looking 100 feet in front of him/her.

â Press OK. The Set Camera dialog is removed and the scene is

viewed from the Honda driver’s perspective, as shown in

Figure 32-48.

â Press Play. The Playback viewer displays the entire sequence

as viewed by the driver of the Honda.
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Figure 32-47 HVE Set Camera dialog,
used for setting the view in the selected

window. In this case, we use the Set
Camera dialog to show how the driver of

the Honda Accord saw the sequence.

Figure 32-48 HVE Playback Window showing the Honda Driver’s view at the start of the
crash sequence. The Honda driver is about to try to pass the Chevrolet Suburban.



Repeat the above steps, using the Set Camera dialog to change the view to watch
the sequence from each driver’s perspective. Simply click on the View From
option list and select each vehicle in the list. The coordinates don’t require
adjusting.

+ NOTE: Even though you used the Set Camera dialog to

set the view, you can still use the viewer controls (thumb

wheels and direct manipulation) to fine-tune the view.

Ending the Tutorial

This concludes Lesson 4 - Creating a Video. In Lesson 4, we learned how to
create a simulation movie file, play it back on our computer in real time, create
a videotape, and save the simulation movie file for future viewing using HVE
(or any other AVI viewer).

You can now shut down HVE.
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